GCSE PHOTOGRAPHY

EXTERNALLY SET TASK
(EXAM)



1. PORTRAITS

Photographic portraits often include objects or props to communicate an idea about the
sitter of the portrait. Lorna Simpson rarely photographs the full face of her sitters but
includes text and objects to communicate personal identities. James Van Der Zee
created A Portrait of Harlem in the 1920s and 1930s, by documenting the lives of local
residents.

Keisha Scarville explores her own identity and culture by referencing the passport
photographs and clothes belonging to her parents. Judith Golden uses combinations of
media to explore ideas about her subject, whereas Platon often exploits tight
compositions and explores lighting to photograph the physical features of the face.

Investigate appropriate sources and produce your own response to Portrait.



LORNA SIMPSON



JAMES VAN DER ZEE
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2. GROUPS

Groups of objects can tell a story and also relate to each other through visual links. Anna
Tomczak uses a variety of photographic processes and materials to create images of
objects that sometimes relate to identity. Olivia Parker selects and arranges groups of

objects that display visual connections with each other. In her commercial and advertising

photographs, Ira Garber often uses groups of carefully arranged objects, lit to emphasise
colour and the qualities of material. Jo Whaley groups together natural forms in her
photography, often to show environmental concerns.

Refer to relevant examples and create your own interpretation in response to Groups.



ANNA TOMCZAK
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3. PLACES & SPACES

Buildings and the landscape are explored by photographers in many different
ways. When photographing buildings, Sebastian Weiss looks for abstract
shapes, dramatic lines and contrasts revealed by camera angle and viewpoint.
Candida Hofer produces series of detailed photographs of the interior of public
buildings that have similar functions, such as museums and libraries. The
street photography of Nicholas Goodden sometimes captures people in
iIsolation from the places and spaces around them. The landscape photography
of Ansel Adams uses small apertures to record fine detail and a maximum
range of focus in the image.

Research relevant examples and develop a personal response to Places and
spaces.



SEBASTIAN WEISS
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NICHOLAS GOODDEN
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4. HANDS

Images of hands can be expressive because of their age, the textures and colours of
skin or through their pose and activity. Dorothea Lange took many photographs of the
hands of workers in the Dust Bowl, California. Angele Etoundi Essamba uses her
photographs to celebrate the identity and strength of African women, often including
their hands as a significant aspect of the composition. Philippe Halsman and Herbert
Bayer used hands to create surreal imagery in their photographs and Tim Booth has
studied hands in close-up, in black and white and in an extensive variety of contexts.

Investigate relevant sources and produce your own response to Hands.



DOROTHEA LANGE




Angele Etoundi Essamba




PHILLIPE HALSMAN

HERBERT BAYER



TIM BOOTH




5. FRAGMENTATION

Photographers sometimes break up, fragment and combine images. Marilyn
Henrion uses fragmented photographic images of buildings as the basis for
constructing mixed media work. Jurgita Remeikyte often combines and
arranges fragmented photographic images in her installations. Laura Letinsky
uses her own photographs to create collages and sometimes produces
compositions using reflections and images on shards of material. David
Seidner presents his photographs of the human form as a fragmented collage.

Refer to suitable sources and make your own response to Fragmentation.
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6. SYMMETRY

Symmetry in composition is used with a wide range of subject matter and
photographic media. Orkhan Mammadov has used traditional symmetrical
patterns as the reference for creating video installations and animated
images. Symmetry can be achieved through digital means and through
reflective surfaces, as in the work of Robert Berdan and Adam Jacobs. In
photographs by Alexander Yakovlev, symmetry is achieved through selecting
an appropriate viewpoint, carefully positioning the subject and choosing a
moment in time. In a similar way, Milos Nejezchleb carefully arranges subject
and colour in his compositions.

Investigate relevant sources and develop your own response to Symmetry.



Orkhan Mammadov
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7. CELEBRATION

The theme Celebration can be interpreted in many ways. Refer to appropriate
sources and develop your own interpretation of Celebration, or respond to one
of the following:

(a) a photographic study that documents a celebration in your community

(b) photographs that explore the variety of texture, colour and form of items
involved in a celebration

(c) ‘Celebration’: a food retailer requires ideas for images that promote a range
of ingredients used in recipes typical of different cultures.

Use photographic skills to produce a visualisation of your proposal for the
client.






CHOOSING THE RIGHT QUESTION

Ask yourself:

What are my strengths and which question works to these?

(Eg. If you are not very confident at Photoshop, don’t choose a question that needs complex editing)

How will | need to take the photographs?

(If you need a certain location or type of person that you do not have access to, then don’t do it. If it requires
studio lighting and you are not willing to spend time at school outside of lesson, then don’t do it).

Can | think of lots of ways to interpret the idea?

Does this question allow me to really experiment and explore
different processes, materials and techniques?



Most Compatible'




NEXT STEPS:

Shortlist the questions to your final two options if you can’t decide
straight away. Circle these on your question paper.

Look online at more of the artists/photographers work to help you decide and
confirm the question you will choose.

If you have chosen one or still have two options, either way the next step is
producing a DETAILED written mind map.



Draft VWritten | Due: Thursday,

Mind Map:

This is done on paper, start in lesson or at
home this evening and then complete it
for homework for Thursday’s lesson.

The homework is to have the written
draft completed, filled with ideas.

Use the Mind Mapping Knowledge
Organiser to help you. Or look at the
simplified layout on the next slide.

DEVELOPING
Mind Mapping

Human brains process visual information thousands
of times faster than text. Also, images are perma-

nently tied to our long-term memaries.

Mind maps are designed to work fike the human
brain warks. They're visual. They're also artistic

and analytical at the same time.

A mind map is a visual thinking tool. It lets you
see the relationships between concepts and infor-

mation. It lets you see hierarchy and connection.

It works like this: you choose a subject. This subject
is the central core around which all other thoughts

are structured.

Then you add ideas and sub-ideas. Join branches of
ideas together and add more. Structure your in-
formation so you can step back and analyse

it.
Combining text, symbols, and visuals together ina
mind map makes complex things easier to under-
stand. You can ses the logical progression of an ides

-how you get from really simple to really detailed.

That makes it easier to think up new concepts and
refine old ones. This skill is central to your
success as a creative.

Do a draft version first,so you can be
as free as possible to record all ideas,
then you can play around with re-
organising it if needed, then add the
visuals.

IDEAS:

How to:

Put the key idea in the centre

Add ideas that link to the central
idea on connected branches, Break
down each branch in to further
expanded ideas.

Record the dictionary definition of
the main idea and synonyms from a
thesaurus, this instantly gives you dif-
ferent interpretations of how you
could approach your idea.

Include artists/photographers, the
wider art movement they belong to,
key words that describe how their
work looks, what materials, pro-
cesses, techniques they use.

Use Pinterest to search for your
idea/theme/photographer to find
more ideas about how youap-
proach your idea and record names
of other photographers and artists
you like.

hughchristiecreative

KNOWLEDGE
ORGANISER




Dictionary definition of the
word and/or related key
words.

What ideas you have for
sets of images you could
take (location, model,
lighting, backdrop, objects
etc.)

What processes/materials,
techniques could you use or
need to learn?

What is it you want to show in your
images? Certain formal elements?
A message/meaning?

How else could you interpret the
theme?

Synonyms (search the key
word/s in online Thesaurus)

Name of the
Question/Starting
Point/Theme

Other related and inspiring
artists/photographers from
Pinterest

Description of their work, materials,
techniques, processes etc.

Photographers/artists listed

in the exam paper

Photographer Photographer Photographer
02 03

Descriptive
words of what
their work
looks like

List what
materials,
techniques or
processes
used

What is their
work about? Is
there a message,
meaning or
purpose?

Descriptive
words of what
their work
looks like

List what
materials,
techniques or
processes
used

What is their
work about? Is
there a message,
meaning or
purpose?

Descriptive
words of what
their work
looks like

List what
materials,
techniques or
processes
used

What is their
work about? Is
there a message,
meaning or
purpose?



ADMIN...

I. Go to your OneDrive folder and make a il PowerPoint Presentation - Saved v
new folder called ‘EXAM’

2. Go into the EXAM folder and then go to e
‘NEW’ and choose PowerPoint. /t

Diana Renton > Abstract Advent >

Animations

pptx

3. When PowerPoint opens, click where is

~  Save status

says Presentation to then rename the bbby
PPT ‘LAST NAME_FIRST
NAM E_EXAM, f:‘ Version History

4. Share the link to your PPT with me -
RENTON



TITLE SLIDE

Find a high-res image
online of one of your
favourite images and
paste it on to your slide.

Add the name of your

chosen exam question, eg.
OBJECTS, LAYERS.

Keep it simple.

GO gle edward weston

Q @ ideos [M] Books ¢ Shopping : More

Time «

v’ Any size

M= pho life g. portrait
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Google Images > Tools > Size > Large
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_ Combine images and text from your
MIND MAPS written mind map. Choose a presentation

Visual & Written style from below:

OPTION | OPTION 2

ANASTAT " \VINOVA
- R D

jANGIE MCONIGAL

Combine images and text together in Photoshop on a
LANDSCAPE document to give you more creative
control over layers, fonts and effects.

Then flatten layer, save as JPEG and insert in to PPT.

Combine images and text together on the same slide in
PowerPoint using contrasting coloured fonts.



_ Combine images and text from your
MIND MAPS written mind map. Choose a presentation
Visual & Written style from below:

OPTION 3

wer  STAORTS wsr  LAND

hOTOGRAPH

v g
ens

PEALING
WATCHING ¢ %
e
=

Input all your text from your written mind map in
Only use images to fill the slide — varying the size/scale to a website like https://www.wordclouds.co.uk/ to
to add interest. make a word cloud. Use similar fonts to title page
and colour scheme.




What images to

include?

A range (min. 4-6) of images from EACH

photographer listed in your chosen question.

Add more or use less depending on your
layout.

Also include any other images you have of
related photographers work that are not
mentioned in the paper. Add to this at
home copy/pasting from Pinterest.

You will probably need to fill up at least 2
slides, maybe 3 or 4 max.

GO gle edward weston

Google Images > Tools > Size > Large




Statement of Intent

Think of this as a written introduction to your exam project. Answer in as much detail as you can (and in
paragraph form and full sentences) these points:

What is the exam project/theme/question you have selected?

Why have you chosen it? (What is it about the theme and/or work by the photographer’s mentioned that you like or are
drawn to?)

In what ways could it be interpreted? What'’s your spin on the theme or ideas you have?
Which are the three main photographers/artists you will chose to focus on and explain what it is about their work that you
like and a little on how you think the work has been made (materials they use/techniques/processes)

Which photographer would you like to focus on first to start making your work? What are your ideas for your first set of
images?

It should be around 150 words or more.
Include some images of the work you like best to illustrate your intent.



Statement of Intent

- Example

| have selected the theme Objects for the examination.| am drawn to this theme because | like how the photographers
combine objects and images together and | think it will allow me to explore and experiment with a range of materials,
techniques and processes.

Inspired mostly by the work of Albert Chong and his Colour Still Lifes, my interpretation will explore the different aspects of
the life of my grandmother through images and objects. | am interested in looking at the journey she took from the UK to
Australia in the 1950’s and which objects and possibly flowers too could represent this. | could use some found images | have
of her at different ages, found postcards, her handwriting and jewellery etc. Linked to this | will also look at the work of
Camilla Catrambone, and her Portraits of My Family series for ideas on how to lay out and arrange objects more formally. | am
also interested in the work of Hong Hao’ and his scanography, | could use the scanner to record objects on top of images
because | like how they appear more three dimensional.

| am keen to explore different ways to combine images, text and objects and could experiment with photograms, Photoshop
layering and printing on to old paper and even over printing images and text on to the same piece of aged paper.

| will start with investigating the work of Albert Chong and will gather together some objects, old photographs of my
grandmother and her handwriting and experiment with different compositions in natural lighting.

(Word count 262)
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| have selected the theme Objects for the examination. | am drawn
to this theme because | like how the photographers combine
objects and images together and | think it will allow me to
explore and experiment with a range of materials, techniques and
processes.

Inspired mostly by the work of Albert Chong and his Colour Still
Lifes, my interpretation will explore the different aspects of the
life of my grandmother through images and objects. | am
interested in looking at the journey she took from the UK to
Australia in the 1950’s and which objects and possibly flowers
too could represent this. | could use some found images | have of
her at different ages, found postcards, her handwriting and
jewellery etc.

Albert Chong




Linked to this | will also look at the work of Camilla
Catrambone, and her Portraits of My Family series for
ideas on how to lay out and arrange objects more
formally. | am also interested in the work of Hong Hao
and his scanography, | could use the scanner to record
objects on top of images because | like how they appear
more three dimensional.

| am keen to explore different ways to combine images,
text and objects and could experiment with photograms,
Photoshop layering and printing on to old paper and
even over printing images and text on to the same piece
of aged paper.

| will start with investigating the work of Albert Chong
and will gather together some objects, old photographs
of my grandmother and her handwriting and experiment
with different compositions in natural lighting.




| st Research and Analysis

CHOOSEYOUR FIRST PHOTOGRAPHER BASED ON THE EASEWITH WHICH
YOU CAN RESPOND. GET ONE OF THEIR IMAGES AND DESCRIBE IT IN AS
MUCH DETAILASYOU CAN

VISUAL;WHAT IS IN IT /WHAT DOES IT LOOK LIKE?

TECHNICAL; HOW WAS IT MADE (COLLAGE / DIGITAL / FILM | MIXED
MEDIA)

CONTEXTUAL; (DOES IT SHARE FEATURESWITH OTHER ART FORMS LIKE
PAINTINGS OR OTHER PHOTOGRAPHERS WORK?)

CONCEPTUAL;IS IT MAKING A STATEMENT ORTRYINGTO SAY
SOMETHING

(SHOW WHY IT LINKSTO THE MAINTOPIC)



|5t Image Analysis Support

This is a photograph of .it/they is/are arranged in a way that shows
symmetry/structure/balance (or a lack of) as the subject is central/off centre, there is/isn’t a lot of
negative space around the main subject and the negative space is busy/empty It is in colour/black
and white.The colours are bright/dull/vibrant and the there is high/limited level of contrast
between the dark and light areas. It is a digital image/film image/collage/mixed media piece of
work that was made or shot in a studio/on location.The artist has produced a series of images in
this style which are similar to the work of other artists like...

| like/don’t like it because...
This image is making a statement that...

It links to the main topic because...

INCLUDE AT LEAST TWO OTHER IMAGES.

THEN GET THE USUAL BASIC INFORMATION ABOUT THIS PHOTOGRAPHERS LIFE.



| st Research and

Analysis

Learning Objective: Demonstrate
an ability to investigate the work of
an artist/photographer relevant to
your question/theme, showing an
understanding of the Visual,
Technical, Contextual and
Conceptual aspects of the work.

* Present your research and
analysis.

* Include overlays to highlight
the focal point and/or
structure of the image.

Shoot
Planner/Contact

Sheet Annotation

If you have not taken your images yet
— add a slide to your PPT after the
research/analysis and respond to the
following.

Explain your idea for your first set:

* What are you photographing?

* Where!

* What type of lighting? Backdrop?

* Why!? — How does it link to your
photographer?



Example Analysis

This shows some notes taken for each aspect about
the Henri-Cartier Bresson photograph to give you an
idea about the sort of things you might write about
in each section.There is an enlarged version on the
next slide.

It then needs to be formulated in to paragraph form
so it flows as a piece of writing.

You can add lines and shapes on top of the image to
show of the composition is arranged like in the
example here. It will help you write about the Visual
aspect.

VISUAL

Repetition of jumping figures - man & woman
on poster (both reflected). Repeated grid
pattern of railings/scaffolding and ladder
treads. Strong contrast and wide tonal range
- deep blacks and bright highlights. Some mid
tones mainly in the background. Wide angle
lens - most of the image in focus. Silhouettes
caused by shooting into the light. Negative
space of puddle in the foreground. Rule of
Thirds used to organise shapes/forms.
Balance of jumping figures anchored by static
figure in background. Strong vertical and
horizontal lines creates stability. Contrast
with frozen movement of the jumping figures
Movement of ladder and jumping man in
opposite directions. Implied movement of
acrobat.

CONTEXTUAL

Cartier-Bresson influenced by Surrealism
(chance, serendipity, the subconscious,
strange juxtapositions, the marvellous in the
everyday). Trained as a painter. Adopted
35mm cameras (Leica). Worked as a photo
journalist - established Magnum agency - and
pioneered distinctive style of candid street
photography. Humanitarian approach.
Published ‘The Decisive Moment' (1952) - "To
me, photography is the simultaneous
recognition, in a fraction of a second, of the
significance of an event as well as of a precise
organization of forms which give that event its
proper expression.” Huge influence on later
photographers e.g. Robert Frank

TECHNICAL

Image taken with 35mm handheld camera
(Leica) - lightweight, easy to operate, quick
response time. Standard 50mm lens
(closest to the viewpoint of the human eye).
Fast film (400 ISO?) copes with relatively
low light - creates grainy image. Available
light - grey, overcast, early evening?
Shutter speed (1/1257) captures slight
motion blur in the jumping man. However,
fast enough to prevent the need for a tripod.
Image printed to reveal some shadow
detail and range of tones. Un-cropped.

CONCEPTUAL

- Photograph as a “decisive” or significant
moment - how does this influence the way
the photographer behaves and looks at
the world?

« Chance - what role does this play in the
creation of all photographic images?

« The city as a type of theatre - pedestrians

as actors in a mysterious drama revealed

or interpreted by the photographer

Photographs as historical documents -

what can we tell about pre-war Paris from

this image?

» Photograph as work of art. Later prints of
this image are valued in excess of
$20,000
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Henri Cartier-Bresson Behind the Gare Saint-L azare, 1932




Analysis Framework Overview

VISUAL

What is the subject matter of the photograph? What is the focal point
(what is your eye drawn to first, and then what else?)

Describe the composition of the photograph — can you identify a
compositional principle?! (eg. Leading lines, strong angles, balance,
positive/negative, repetition etc.

What are the key formal elements used in the photograph? How do
they work to create a successful photograph?

TECHNICAL

How has the work been made?
What type of lighting do you think has been used? (and what
evidence tells you that?)

How would you describe the depth of field used? (Is it shallow
or wide?) What areas in the photograph are in focus and what
areas are blurred?

What type of shutter speed do you think has been used (fast or
slow?) and why do you think that?

Can you give some context to the photograph?
The context of the photograph could be:

Historical:

Place in time, local/national/global events

Visual:

Does the photograph belong to a wider art/photographic movement,
genre, style

Personal:

What is the background of the photographer — have their personal
experiences shaped their view

CONCEPTUAL o2

‘\\‘. J

What do you think the photographer might be trying to show?

Is there a message they could be trying to say? (What is it and why do
you think that?) Is the work trying to highlight a point?

What is your personal opinion about the work — how does the
image affect YOU?

How does the photograph make you feel? Why do you think you
feel like this?

What do you like or dislike about the image and why? Use
PHOTOGRAPHIC TERMS to justify your opinions
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What is the subject matter of the photograph? What is
the focal point (what is your eye drawn to first, and
then what else!?

Describe the composition of the Photograph — can you
identify a compositional principle? (eg. Leading lines,
strong angles, balance, repetition etc.

Can you overlay lines/circles on to the image to show
the structure of the composition? (see an example of

this on slide X)

What are the key formal elements used in the
photograph? How do they work to create a successful
photograph!?

Key Terms to Consider and Use:
Formal Elements

* Colour ( & Colour Theory terms)
Tone (light & dark) « Texture (surface)
* Shape (2D, flat) * Form (3D)
Pattern (repetition) * Line

Composition:

Layout, arrangement, organisation,
selection, cropping,
containment/confinement (within
frame), Leading lines/leading the eye,
Emphasis, Repetition,Viewpoint,
Balance, Harmony, Contrast, Tension,
Foreground, middle ground,
background, Rule of Thirds, Golden
Section/Ratio, Depth of surface
illusion...




Technical

* What type of lighting do you think has been
used? (and what evidence tells you that?)

* How would you describe the depth of field
used? (Is it shallow or wide?) What areas in
the photograph are in focus and what areas
are blurred?

* What type of shutter speed do you think
has been used (fast or slow?) and why do
you think that?

Key Terms to Consider and Use:

Lighting:

Type of lighting E.g. natural/daylight,
tungsten, flash, fluorescent, shade...
Level of control E.g.
positioned/located, reflected,
manipulated, intensity, distance...
Relevant key words: tonal range,
contrast, saturated, over / under
exposed, glare...

Aperture: Lens (lens size, macro,
telephoto, wide angle, settings: f-
stops...) Focal point, depth of field
(DoF) — shallow/wide, sharp, focused,
blurred, vignette...

Shutter Speed: Exposure time,
over/under exposed, motion blur,
sharp, frozen, panning...




* Can you give some context to the photograph!?

To answer this, you will need to research the selected
phhotogrﬂph to fynd wider background information about
the work.

* Historical: Place in time, local/national/global
events

* Visual: Does the photograph belong to a wider
art/photographic movement, genre, style

* Personal: What is the background of the
photographer — have their personal experiences
shaped their view?

Key Terms to Consider and Use:
Context Definition:

The circumstances that form the setting
for an event, statement, or idea, and in

terms of which it can be fully understood.

Eg. The context of the
photograph could be:

Historical:

Place in time, local/national/global
events

Visual:

Does the photograph belong to a
wider art/photographic movement,
genre, style

Personal:

What is the background of the
photographer — have their personal
experiences shaped their view
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* What do you think the photographer might be trying to
show!?

Is there a message they could be trying to say? (What is it and why
do you think that?) Is the work trying to highlight something?

* What is your personal opinion about the work — how does
the image affect YOU?

* How does the photograph make you feel or think about?
Why do you think you feel like this?

* What do you like or dislike about the image and why? Use
PHOTOGRAPHIC TERMS to justify your opinions.

Key Terms to Consider and Use:

Concept Definition:

An idea, plan or intention

Sentence Starter ldeas:

‘I think the photographer is trying to
show................. and | think they have
done this successfully because............
I think this is a good photograph

because of how the photographer has
shown/used/chosen...... etc’

)




Repetition of jumping figures - man & woman

on poster (both reflected). Repeated grid
pattern of railings/scaffolding and ladder

treads. Strong contrast and wide tonal range

- deep blacks and bright highlights. Some mid
tones mainly in the background. Wide angle

lens - most of the image in focus. Silhouettes

caused by shooting into the light. Negative
space of puddle in the foreground. Rule of
Thirds used to organise shapes/forms.

Balance of jumping figures anchored by static

figure in background. Strong vertical and
horizontal lines creates stability. Contrast
with frozen movement of the jumping figures.
Movement of ladder and jumping man in
opposite directions. Implied movement of
acrobat.

CONTEXTUAL

Cartier-Bresson influenced by Surrealism
{chance, serendipity, the subconscious,
strange juxtapositions, the marvellous in the
everyday). Trained as a painter. Adopted
35mm cameras (Leica). Worked as a photo

journalist - established Magnum agency - and

pioneered distinctive style of candid street
photography. Humanitarian approach.

Published ‘The Decisive Moment' (1952) - "To

me, photography is the simultaneous
recognition, in a fraction of a second, of the

significance of an event as well as of a precise

organization of forms which give that event its
proper expression.” Huge influence on later
photographers e.g. Robert Frank

Image taken with 35mm handheld camera
{Leica) - lightweight, easy to operate, quick
response time. Standard 50mm lens
(closest to the viewpoint of the human eye).
Fast film (400 ISO?) copes with relatively
low light - creates grainy image. Available
light - grey, overcast, early evening?
Shutter speed (1/1257) captures slight
motion blur in the jumping man. However,
fast enough to prevent the need for a tripod.
Image printed to reveal some shadow
detail and range of tones. Un-cropped.

CONCEPTUAL

= Photograph as a “decisive” or significant
moment - how does this influence the way
the photographer behaves and looks at
the world?

= Chance - what role does this play in the
creation of all photographic images?

= The city as a type of theatre - pedestrians
as actors in a mysterious drama revealed
or interpreted by the photographer

- Photographs as historical documents -
what can we tell about pre-war Paris from
this image?

= Photograph as work of art. Later prints of
this image are valued in excess of
$20,000

R
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Henri Cartier-Bresson Behind the Gare Saint-Lazare, 1932




| st Research

Simplified

Research:

Introduce the artist/photographer with brief biographical info
— and tell us what sort of work are the best known for
(Portraits? Landscape? Still Life?)

Give a general description of their work as a whole (you will
go in to more specific detail in your analysis).

Explain how they make/create their work —is it
digital/Photoshop? Collage/Physical? Or analogue (film or B&W
prints?) What materials do they use?

What do you think the work is about or could be trying to say
or show?! Why!?

Writing Frames:

.......... Is best known for their
............. work, which
depicts/shows/captures images

of.......... 13 PR lighting. The
work can be described
U



|5t Set of Images

. Upload, remove/delete any bad shots

Make a contact sheet using Adobe Bridge or File Explorer
Print to PDF.

Present your |5t Set of Images on the next slide/s. Include
a title, this could be It Set of Images or Name of
Photographer Response.

Include an annotation to explain what you trying to explore
(what ideas?), how you took the images
(lighting?angle?location?camera settings?).

. Write about how well the set went — was are the strengths
and why and could you have done anything differently and
why?

Writing Frames:

For this set of images |
explored/experimented with taking
images of ............. in response to the
photographer-............

| took the images using ............
| am pleased/happy with how

| could have also.................. to
improve.......



MAKING A CONTACT SHEET

Bh Contact Sheet I

Cx ) Just click OK on this screen and
e it will automatically open

|. Open Adobe Bridge> This PC> Find your saved images
Photoshop and start making

and select the images. You can click and drag or hold down
the contact sheet.

CTRL to select specific images only.

I Rowan &
ile Edit View Stacks Label Tools Window Help
: Batch Rename... Ctrl=Shift+ R

Create Metadats Template... > R RowanA
Edit Metadata Template

Append Metadata

Replace Metadata

' l Y ¥ Lens Comection...
[ - L Load Files into Photoshop Layers...
/ - o Merge to HDR Pro...

-

NG ETILINE  IMGETIZIPG  IMG EIING | IMG IR Photomerge...
Process Collections in Photoshop

'E:m " ‘ .- Bt 3 bl | s | W 2. Once the Contact Sheet is made, you must go to
C.r.llan‘rr.‘fﬂc 1 | B = | I_ # ' —T 4

ks menre Besuve [smsnre Layer>Flatten Image and save it as a .|JPEG
If you have 40 plus images, you will need to make the contact
sheets in batches, to avoid the program closing. See the total
number of images and then divide them in to even amounts to
make contact sheets.




|5t Set of Images:

EDITS

Carefully look through all your images, select the very
best ones to edit in Photoshop.

As a guide you should have at least 4-6 as a basic set of
edits, some student will have more, approx. 8-10.

Editing:
Cropping if needed.

Filter>Camera RAW Filter for all tonal, colour, sharpening
etc. See next slide for explanation.

Presenting:
Order your edits so they are increasing in quality. Only
present 2 edits per slide maximum.

Annotation:

If your images are similar and
you have edited them using the
same tools, then on the final
slide you can copy and paste
each edit on to the slide, smaller
in scale.

Align them in a grid.

Add text underneath to explain
how you refined the images.

If you editing is more complex,
you can add screenshots to
illustrate the process.



General adjustments in e
Camera RAWV Filter L

Edit

Profile | Calor

Every image you edit needs to use the Camera RAW Filter.
The main elements to adjust and tweak are:

v  Basic

All the tonal tools:

Exposure, Contrast, Highlights, Shadows, Whites, Blacks

Highlights
Shadows
Whites

Blacks

Temperature (only ever very slightly) rerare
Saturation (only very slightly either way)

Definition:

Saturation

» Curve

Clarity (increases the contrast and texture)
In the Detail drop down, choose Sharpen — adjust to about 40

> Detail

» Color Mixer




Experiment & Refine (25%)

You need to explore as many relevant,
different techniques or processes as

Making outcomes that look like the work of possible.

the photographers you researched is a key
part of the project. Here are some processes you can use.

You may have already done this if they had a  Collage; physical printing of images
straight forward photographic style but if it ~ Which are then cut and stuck together

involved a more in-depth style of in layers

photographic practice you are going to have  Digital Editing; any Photoshop editing

to explore a way of recreating that. Darkroom; exploring how to use the
darkroom to support your outcomes

| can help with ideas of course but you Mixed Media; using paint or other

should come to me with an idea not just a physical resources to explore visual

problem! ideas.



YOU HAVE TO BE DOING ONE OF THESE TASKS AND
SHOULD HAVE THREE SEPARATE CYCLES OF EACH ONE

BY THE 16™ FEB

Photographer Research

Contact sheet and Basic Edits

Further Experiments

Collage; physical printing of images
which are then cut and stuck together
in layers

Digital Editing; any Photoshop editing
Darkroom; exploring how to use the
darkroom to support your outcomes
Mixed Media; using paint or other
physical resources to explore visual
ideas.



